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DesignDRIVE is a single hardware and software platform that makes it easy to develop and evaluate 
solutions for many industrial drive and servo topologies. The DesignDRIVE kit and example software offer 
an easy path to begin exploring a wide variety of motor types, sensing technologies, encoder standards and 
communications networks, as well as easy expansion to develop with real-time Ethernet communications 
and functional safety topologies, enabling more comprehensive, integrated system solutions.  
 
With C2000 DesignDRIVE Software and Kit (IDDK), TI wants to help you spend more of your time 
differentiating your product in your core areas and less of it evaluating new technologies that will eventually 
become table stakes in the industry. Using DesignDRIVE will ultimately help you get to market faster, with a 
more valuable product. 
 
Based on the real-time control architecture of TI’s C2000 microcontrollers, DesignDRIVE is ideal for the 
development of industrial inverter and servo drives used in robotics, computer numerical control (CNC) 
machinery, elevators, materials conveyance and other industrial manufacturing applications.  
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1 Introduction 

 
This guide explains the steps needed to run the motor with IDDK using the software supplied through 
controlSUITE. ControlSUITE is a suite of example projects using TI’s C2000 devices, containing technical 
literature that includes software, to verify the stated functional objective of the project. It is an open source 
code from Texas Instruments supporting C2000 devices and can be downloaded from 
http://www.ti.com/tool/controlsuite.  
 
The following projects are currently available for IDDK based on TMS320F28377x MCU.  
                      

 IDDK_PM_Servo_F2837x: Sensored Field Oriented Control of Permanent Magnet Motor 
 
Project features:  

 Position, Speed and Torque control loops 

 On-chip Position Sensor Support: Resolver, Incremental Encoder (QEP) 

 Simultaneous Current Sensing Support for: Fluxgate/Hall, Delta-Sigma, Shunt 
 
 

It is important for the user to read the kit’s Hardware Reference Guide and understand all the safety 
measures needed to be taken to work with the kit. When ControlSUITE is installed, the Hardware 
Reference Guide can be found at: 
 
       controlSUITE\development_kits\TMDSIDDK_v1.0\~Docs\ 

 

And, the software can be found at: 
  
     controlSUITE\development_kits\TMDSIDDK_v1.0\IDDK_PM_Servo_F2837x 

 

 
Please read this document and the Hardware Reference Guide thoroughly before attempting to use the kit 
the first time. 

 

WARNING 
 

This EVM is meant to be operated in a lab environment only and is not considered 
by TI to be a finished end-product fit for general consumer use. 
 
This EVM must be used only by qualified engineers and technicians familiar with 
risks associated with handling high voltage electrical and mechanical components, 
systems and subsystems.  

 
This equipment operates at voltages and currents that can result in electrical shock, fire hazard and/or 
personal injury if not properly handled or applied. Equipment must be used with necessary caution 
and appropriate safeguards must be employed to avoid personal injury or property damage.  
 
It is the user’s responsibility to confirm that the voltages are identified and understood, prior to 
energizing the board and or simulation. When energized, the EVM or components connected to the 
EVM should not be touched.  
Isolation transformers must be used when connecting grounded equipment to the EVM.  

http://www.ti.com/tool/controlsuite
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2 Hardware Configuration 

 
To experiment with IDDK for digital motor control, the following components are needed: 

 An IDDK EVM 

 TMDXCNCD28377D 

 USB-B to A Cable 

 PMSM motor for evaluation  

o Not included with TMDXIDDK377D 

o Included with TMDXIDDK377D-MTR-BNDL bundle  

o Also available standalone from TI eStore, part # HVPMSMMTR 

 An incremental encoder or resolver; (QEP included with motor available on TI eStore) 

 An external isolated 15V power supply needed for MCU code development (preferably with a barrel 
connector commonly referred to as DC jack) 

 A high voltage DC power supply (isolated)  

 PC with Code Composer Studio (CCSv6 or greater) installed; 

 Additional instruments such as an oscilloscope, a digital multimeter, a current sensing probe and a 
function generator.  

 
The experimental setup and connection are illustrated in the following sections. For details about the kit 
hardware, refer to the Hardware Reference Guide located at  

controlSUITE\development_kits\TMDSIDDK_v1.0\~Docs\ 
 
For the schematic details of IDDK EVM, refer to the schematic file located at 

controlSUITE\development_kits\TMDSIDDK_v1.0\IDDK_HwDevPkg\IDDK_HwDevPkg_v2.2. 
 

 
 

Figure 1  DesignDRIVE Kit (IDDK) 
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2.1 Hardware Layout of IDDK 

 
The IDDK is designed by integrating various function specific macro blocks as shown in fig.2 below. 
Following is the list of all macros with description of what each is responsible for on the board.  
 

 
Figure 2 Layout of IDDK EVM with its functional macros 

 [Main] – processor slots, jumpers, inter processor communications and DACs and all sections not 
covered by any other macro 

 [M1] - AC power entry takes AC power from the wall/mains power supply and rectifies it. This can then be 
used as the DC bus for the inverter.  

 [M2]  - Auxiliary power supply-1, 400V to 5V and 15V module, can generate 15V, 5V power for the 
inverter section of the board from rectified AC power. However, through proper jumper settings, it can be 
used to provide 15V to the entire board. 

 [M8] - Auxiliary power supply-2, 400V to 5V and 15V module, can generate 15V, 5V power for the control 
section of the board from rectified AC power. However, through proper jumper settings, it can be 
configured to provide 15V to the entire board. 

 [M3] - DC power Entry 1 generates 15V, 5V and 3.3V for the HV section of the board from DC power fed 
through the DC-jack using an external or [M2] power supply.  Through proper jumper settings, this can 
power the entire board. 

 [M9] - DC power Entry 2 generates 15V, 5V and 3.3V for the control section of the board from DC power 
fed through the DC-jack using an external or [M8] power supply. Through proper jumper settings, this can 
power the entire board.  
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 [M4] - Three-phase inverter, to enable control of high voltage 3-phase motors. 

 [M5] – Flux gate current sensor module that provides isolated voltage feedback of motor phase currents V 
and W.  

 [M6] – Over current protection module that generates a TRIP signal to shutdown the inverter in the event 
of over current through the motor. 

 [M7] – Sigma-delta interface module that provides motor phase current feedback to the CPU for digital 
control of motor 

 [M10] – Interface module that translates 5V logic signals from an incremental encoder into 3.3V for the 
C2000 and its QEP peripheral 

 [M11] – Analog interface module to work with RESOLVER position sensor 

 [M12] – Digital interface module to work with a BISS or EnDAT position encoder 

 [M13] – Analog interface module to work with Sin/Cos position encoder 
 
 
In this document, each component is referenced with their macro number in the brackets followed by a dash 
and the reference number. For example,  

- [M3]-J1 refers to the jumper J1 located in the macro M3. 
- [Main]-J1 refers to the jumper J1 located on the board, but outside of the macro blocks defined 

above.  
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2.2 IDDK Power Supplies 

 
Typical of motor drive platforms, IDDK has a low voltage domain represented by the controller and a high 
voltage domain represented by rectifier and inverter  

2.2.1 Low Voltage Power Domain  

This represents the 15V, 5V and 3.3V needed to power the MCU, logic, sensing and driver circuits on 
IDDK. Power input for this domain can be provided by: 

 
1.    Connecting an isolated 15V DC power supply to the DC Jack ([M3]-JP1 / [M9]-JP1) present on the 

DC Power entry Macro.  

2.    An auxiliary power supply module [M2] / M[8]) present on the board that can generate 15V and 5V 
DC from the high voltage DC link.  

o Since the input voltage range of this module is 90V-400V, auxiliary modules will not be 
suitable if the DC bus voltage can go below 90V during the tests. In such cases, option 1 
described above is recommended. 

 
3.    [M3] and [M9] are identical macros that provide the same set of output voltages, which can be 

configured to power the entire controller or just the gate drives of the inverter, depending on choice 
as explained in the Hardware Guide.  
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
  

For safety and convenience during general code development, testing and 
verification, it is preferable to use an external isolated 15V power supply to power 
the control section of the board through DC power entry macro [M9] (or [M3]).   

Default configuration of the kit :- 
- [M9] is set up as low voltage power source 
- Both control GND and power GND planes are connected 

The control GND and power GND can be separate or tied together depending on need. If 
they are tied together, then obviously the control GND will be HOT, otherwise control GND 
will be COLD. Refer to the Hardware Guide for details. 

For user applications requiring a COLD control GND :-  
Shunt current sensing method cannot be used. Refer to Section 3.7 on Power Supplies 
and GND plane configurations in the Hardware Guide for details 



Texas Instruments Incorporated                           

 

 8 Rev1.0

   

 

2.2.2 High Voltage Power Domain  

This represents the DC link section powering the inverter that generates three phase voltages for the 
motor. There are two ways to provide this voltage to the inverter, as given below:  

 
1.    Connecting an external isolated variable DC power supply (Max 350V) using banana jacks to 

[Main]-BS2 and [Main]-BS3 of IDDK. Using this power supply is recommended during experiments. 
To power the auxiliary power supply modules [M2] / M[8], connect [Main]-BS3 and [Main]-BS1 

2.    Connecting the kit to AC Mains through P1 (110V* or 220V AC). An on board rectifier converts AC 
to DC. For safety, use of a variac (variable AC transformer) and isolator is recommended when 
using this power source.  

 
NOTE: Keep all power supplies at zero unless directed to energize 
* Note that the 3-ph Induction motors are typically rated at 220V AC, so a 320V DC-bus voltage is needed. Thus, when using 110V AC 
power source to generate the DC Bus for the inverter (150V), the motor can run properly up to a certain speed and torque range 
without saturating the PID regulators in the control loop.  As an option, the user can directly connect a DC power supply. 
 
 

 
 

  

Note that the ground planes of both the power domains can be same or different 
depending on hardware configuration, hence proper isolation requirements must be met 
before connecting any test equipment with the board. 
 

Review the GND connections in the Hardware Guide before powering the 

board 
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3 Test Hardware Setup Instructions 
 
The experiment uses a single common HOT GND, connecting the control and power circuits, as shown in 
line entry 4 of Table 2 in IDDK Hardware Reference Guide, and is set as the default configuration. 
 
Follow the steps given below for setting up the experimental hardware 

1. Ensure default configuration – Make sure that jumpers [Main]-J6, [Main]-J7 and [Main]-J8 in front of 
macro M9 and that  resistors [Main] R8-R13 are populated, and that GND plane resistors R14 and R15 
are mounted as shown in Figure 13 and Figure 14 of Power Supplies Section of Hardware Reference 
Guide 

2. Unpack the TMDXCNCD28377D control card and slide it down in the connector slot of [Main]-H1. Push 
down vertically using even pressure on both ends of the card until it cannot slide down further. (to 
remove the card spread open the retaining clips, if present, and pull the card out applying even force at 
the far edges) 

3. Connect a USB cable to connector J1 on the control card. The control card isolates the JTAG signals 
between the C2000 device and the computer. LED D2 on the control card should light.  

4. Ensure that toggle switch [M9]-SW1 is in “Int” position. Connect an isolated 15V DC power supply to 
[M9]-JP1. 

5. Turn on toggle switch [M9]-SW1. Now [M9]-LD1 should turn on. Note that more LEDs on the control 
card should light up indicating that the control card is receiving power from the board. 

6. Note that the motor should be connected to [Main]-TB1 terminals only after finishing with the first 
incremental build step. 

7. Note the DC Bus power should only be applied when instructed to do so. The two options to get 
DC Bus power are discussed below 

1. To use an external variable DC power supply, set the power supply output to zero and connect 
[Main]-BS2 and [Main]-BS3 to the + and – terminal of the DC power supply respectively as shown in 
Figure 3 below. 

2. To use AC Mains Power, connect [Main]-BS1 to [Main]-BS2 using banana plug cord. Then connect 
one end of the AC power cord to [Main]-P1. Connect the other end to the output of a variac after 
ensuring that its output is set to zero and that it is connected to the wall supply through an isolator as 

shown in Figure 4 below.  

   
 

 

WARNING: DC bus capacitors will remain charged for a long time after the 

mains supply is disconnected. Use caution! 
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Figure 3 Connection diagram with external variable DC power supply providing DC bus voltage 
 
 

 
 

WARNING: DC bus capacitors will remain charged for a long time after the 

mains supply is disconnected. Use caution! 
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Figure 4 Connection diagram with AC input 

 
 

 

WARNING: DC bus capacitors will remain charged for a long time after the 

mains supply is disconnected. Use caution! 
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4 Software Setup for IDDK Projects 

 

Installing Code Composer and controlSUITE 

 
1. If not already installed, please install Code Composer v6.x or later from 

http://www.ti.com/tool/CCSTUDIO 
 

2. Go to http://www.ti.com/controlsuite and run the controlSUITE installer.  Allow the installer to 
download and update any automatically checked software for C2000. 
 

 

Setup Code Composer Studio to Work with TMDXIDDK377D 

3. Open “Code Composer Studio”.  Note that this document assumes version 6 or later.   

4. Once Code Composer Studio opens, the workspace launcher may appear that would ask to select 
a workspace location,:  (please note workspace is a location on the hard drive where all the user 
settings for the IDE i.e. which projects are open, what configuration is selected etc. are saved, this 
can be anywhere on the disk, the location mentioned below is just for reference. Also note that if 
this is not your first-time running Code Composer the dialog below may not appear) 

 Click the “Browse…” button 

 Create the path below by making new folders as necessary. 

 “C:\c2000 projects\CCSv6_workspaces\IDDK_workspace” 

 Uncheck the box that says “Use this as the default and do not ask again”. 

 Click “OK” 

 
Figure 5 Workspace Launcher 

5. This will open a ‘Getting Started’ tab with links to various tasks from creating a new project, 
importing an existing project to watching a Tutorial on CCS. The user can click the ‘Import Project’ 
Icon that will skip the procedure to step 10 in this list. Or, we can close the ‘Getting Started’ Tab and 
go to next step.  

6. Next we will configure Code Composer to know which MCU it will be connecting to. This is done by 
setting up the ‘Target Configuration’. All these are already set up and configured in 
“xds100v2_F2837x.ccxml” provided as part of the files in project, and the user can skip to step 9. 
However, for general information regarding setting up this configuration file, steps 6, 7 and 8 can be 
used. 

7. A new configuration file can be set by clicking “View  Target Configuration. This will open the 

Target Configuration window. In this window, click on .  Give a name to the new configuration file 

http://www.ti.com/tool/CCSTUDIO
http://www.ti.com/controlsuite
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depending on the target device.  If “Use shared location” checkbox is checked, then this config file 
can be stored in a common location by CCS for use by other projects as well. Then click Finish.  

 

8. This should open up a new tab as shown in Figure 6.  Select and enter the options as shown: 

 Connection – Texas Instruments XDS100v2 USB Emulator (or)  

                Texas Instruments XDS100v2 USB Debug Probe 

 Device – the C2000 MCU on the control card, TMS320F28377D, for example 

 Click Save and close  

 
 

Figure 6 Configuring a new target 

 
9. Click “View->Target Configurations”. In the “User Defined” section, find the file that was created in 

step 6 and 7. Right-click on this file and select “Set as Default”. To use the configuration file 
supplied with the project, click “View->Target Configurations, then expand “Projects 
IDDK_PM_Servo_F2837x and right-click on the file “xds100v2_F2837x.ccxml” and “Set as Default”. 
This tab also allows you to reuse existing target configurations and link them to specific projects. 

10. Add the motor control projects into the current workspace by clicking “Project->Import CCS Project”. 

 Select the IDDK project by browsing to: 

“C:\TI\ controlSUITE\development_kits\TMDSIDDK_v1.0\IDDK_PM_Servo_F2837x” 
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Figure 7 Adding IDDK project to workspace 
 

 If there are multiple projects in this directory, then the user can click and choose the projects to 
import, and then click Finish.  This will copy all the selected projects into the workspace. In this 
figure above, we have one project only, select it and click finish. 

 

Configuring a Project 

11. Assuming this is your first time using Code Composer, the xds100v2-F2837x should have been set 
as the default target configuration. Verify this by viewing the xds100v2-f2837x.ccxml file in the 
expanded project structure and a [Active/Default] status written next to it. By going to “View-> 
Target Configurations” you may edit existing target configurations or change the default or active 
configuration. You can also link a target configuration to a project in the workspace by right clicking 
on the Target configuration name and selecting Link to Project.  

12. The project can be configured to create code and run in either flash or RAM. You may select either 
of the two, however for lab experiments we will use RAM configuration most of the time and move 

to the FLASH configuration for production. As shown in Figure 8, right-click on an individual project 

and select Active Build Configuration-> F2837x_RAM configuration. 
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Figure 8 Selecting the F2837x_RAM configuration 

 

Build and Load the Project 

13. The TI motor control software is provided with incremental builds where different components / 
macro blocks of the system are pieced together one by one to form the entire system. This helps in 
step by step debug and understanding of the system. From the CCS Edit Perspective, open the file 
[Project-Name]-Settings.h and make sure that BUILDLEVEL is set to LEVEL1 and save this file. 
After we test build 1, this variable will need to be redefined to move on to build 2, and so on until all 
builds are complete. 

14. Open the [Project-Name].c file and go to the function MainISR(). Locate the following piece of code 
in incremental build 1 and confirm that the Datalog buffers are pointing to the right variables. These 
Datalog buffers are large arrays that contain value-triggered data that can then be displayed to a 
graph. Note that in other incremental builds different variables may be put into this buffer to be 
graphed. Following is an example where the datalog are pointed to the space vector generator 
module.  

dval1=rg1.Out; 
  dval2=svgen1.Ta; 
  dval3=svgen1.Tb; 
  dval4=svgen1.Tc; 
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15. Now Right Click on the Project Name and click on “Rebuild Project” and watch the Console window. 
Any errors in the project will be displayed in the Console window.  

16. On successful completion of the build click the  “Debug” button, located in the top-left side of the 
screen, and the following window may pop up, if it is the first time, requesting select which of the 
two CPUs in F28377x to connect to. Choose CPU1 by clicking the box next to CPU1. 

 

Figure 9 Selecting the CPU(s) to connect 

17. The IDE will now automatically connect to the target, load the output file into the device and change 
to the Debug perspective. 

18. Click “Tools->Debugger Options->Program / Memory Load Options”. You can enable the debugger 
to reset the processor each time it reloads program by checking “Reset the target on program load 
or restart” and click “Remember My Settings” to make this setting permanent.  

19. Now click on the “Enable silicon real-time mode” button  which also auto selects “Enable polite 

real-time mode” button . This will allow the user to edit and view variables in real-time. Do not 
reset the CPU without disabling these realtime options! 

20. A message box may appear. If so, select YES to enable debug events. This will set bit 1 (DGBM bit) 
of status register 1 (ST1) to a “0”. The DGBM is the debug enable mask bit. When the DGBM bit is 
set to “0”, memory and register values can be passed to the host processor for updating the 
debugger windows. 
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Setup Watch Window & Graphs 
Click: View  Expressions on the menu bar to open a watch window to view the variables being used in the 
project. Add variables to the watch window as shown below. It uses the number format associated with 
variables during declaration. You can select a desired number format for the variable by right clicking on it 
and choosing. Figure below shows a typical expressions window. 
 

 

Figure 10 Configuring the Expressions Window 

Alternately, a group of variables can be imported into the Expressions window, by right clicking within 
Expressions Window and clicking Import, and browse to the .txt file containing these variables. Here, 
browse to the root directory of the project and pick ‘Variables_IDDK_Level1.txt’ and click OK to import the 
variables shown in Figure 10.  

 

21. Click on the Continuous Refresh button  in the watch window. This enables the window to run 
with real-time mode.  By clicking the down arrow in this watch window, you may select “Customize 
Continuous Refresh Interval” and edit the refresh rate of the watch window.  Note that choosing too 
fast an interval may affect performance. 
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22. The datalog buffers point to different system variables depending on the build level. They provide a 
means to visually inspect the variables and judge system performance. Open and setup time graph 
windows to plot the data log buffers as shown below. Alternatively, the user can import graph 
configurations files in the project folder by clicking: Tools -> Graph -> DualTime… and select import 
and browse to the following location 

C:\TI\ControlSUITE\developement_kits\TMDSIDDK_v1.0\IDDK_PM_Servo_F2837x 

and select Graph1.graphProp, the Graph Properties window should now look like the Figure 11. Hit 
OK, this should add the Graphs to your debug perspective. Click on Continuous Refresh button  
on the top left corner of the graph tab. 

Note: If a second graph window is used, you could import Graph2.prop, the start Addresses for this 
should be DBUFF_4CH3 and DBUFF_4CH4.  

Note: The default dlog.prescaler is set to 5 which will allow the dlog function to only log one out of 
every five samples. 

Note: The default dlog.trig_value should be set to the right value to generate trigger for the plot as 
in oscilloscopes. 

 

 
 

Figure 11 Graph window settings 
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Run the Code 

23. Run the code by pressing Run Button  in the Debug Tab. 

24. In the Expressions window, set the variable ‘EnableFlag’ to 1. 

25. The project should now run, and the values in the graphs and watch window should continuously 
update. Below are some screen captures of typical CCS perspectives while using this project. You 
may want to resize the windows according to your preference.  

26. Once complete, reset the processor       (Run->Reset->CPU Reset) and then terminate the debug 

session by clicking   (Run->Terminate). This will halt the program and disconnect Code 
Composer from the MCU. 

 

 

Figure 12  CCS IDE showing Edit Perspective 
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Figure 13 CCS IDE showing Debug Perspective 

 
Next Steps 

27. It is not necessary to terminate the debug session each time the user changes or runs the code 
again. Instead the following procedure can be followed. After rebuilding the project, (Run->Reset-

>CPU Reset) , (Run->Restart ) , and enable realtime options. Once complete, disable realtime 
options, and reset CPU. Terminate the project if the target device or the configuration is changed 
(Ram to Flash or Flash to Ram) and prior to shutting down CCS. 

28. Customize the project to meet your motor and feedback sensor options. Change the sensor type in 
IDDK_PM_Servo_F2837x-Settings.h. Feel free to also change the PWM switching frequency (ISR 
frequency). The ISR frequency should be chosen as a submultiple of PWM frequency for which 
some code modification needs to be done 

29. Now the user can open the lab manual found in:  

C:\TI\controlSUITE\development_kits\TMDSIDDK_v1.0\IDDK_PM_Servo_F2837x\~Docs 

and start the experiments. 
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5 Revision History 

Version Date Change Description 

1.0 May 2015 First Release 
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ADDITIONAL TERMS AND CONDITIONS, WARNINGS, RESTRICTIONS, AND DISCLAIMERS 
FOR EVALUATION MODULES 

Texas Instruments Incorporated (TI) markets, sells, and loans all evaluation boards, kits, and/or modules 
(EVMs) pursuant to, and user expressly acknowledges, represents, and agrees, and takes sole 
responsibility and risk with respect to, the following:  

1. User agrees and acknowledges that EVMs are intended to be handled and used for feasibility 
evaluation only in laboratory and/or development environments. Notwithstanding the foregoing, in 
certain instances, TI makes certain EVMs available to users that do not handle and use EVMs solely for 
feasibility evaluation only in laboratory and/or development environments, but may use EVMs in a 
hobbyist environment. All EVMs made available to hobbyist users are FCC certified, as applicable. 
Hobbyist users acknowledge, agree, and shall comply with all applicable terms, conditions, warnings, 
and restrictions in this document and are subject to the disclaimer and indemnity provisions included in 
this document.  

2. Unless otherwise indicated, EVMs are not finished products and not intended for consumer use. EVMs 
are intended solely for use by technically qualified electronics experts who are familiar with the dangers 
and application risks associated with handling electrical mechanical components, systems, and 
subsystems.  

3. User agrees that EVMs shall not be used as, or incorporated into, all or any part of a finished product.  

4. User agrees and acknowledges that certain EVMs may not be designed or manufactured by TI. 

5. User must read the user's guide and all other documentation accompanying EVMs, including without 
limitation any warning or restriction notices, prior to handling and/or using EVMs. Such notices contain 
important safety information related to, for example, temperatures and voltages. For additional 
information on TI's environmental and/or safety programs, please visit www.ti.com/esh or contact TI.  

6. User assumes all responsibility, obligation, and any corresponding liability for proper and safe handling 
and use of EVMs. 

7. Should any EVM not meet the specifications indicated in the user’s guide or other documentation 
accompanying such EVM, the EVM may be returned to TI within 30 days from the date of delivery for a 
full refund. THE FOREGOING LIMITED WARRANTY IS THE EXCLUSIVE WARRANTY MADE BY TI 
TO USER AND IS IN LIEU OF ALL OTHER WARRANTIES, EXPRESSED, IMPLIED, OR 
STATUTORY, INCLUDING ANY WARRANTY OF MERCHANTABILITY OR FITNESS FOR ANY 
PARTICULAR PURPOSE. TI SHALL NOT BE LIABLE TO USER FOR ANY INDIRECT, SPECIAL, 
INCIDENTAL, OR CONSEQUENTIAL DAMAGES RELATED TO THE HANDLING OR USE OF ANY 
EVM.  

8. No license is granted under any patent right or other intellectual property right of TI covering or relating 
to any machine, process, or combination in which EVMs might be or are used. TI currently deals with a 
variety of customers, and therefore TI’s arrangement with the user is not exclusive. TI assumes no 
liability for applications assistance, customer product design, software performance, or infringement of 
patents or services with respect to the handling or use of EVMs.  

9. User assumes sole responsibility to determine whether EVMs may be subject to any applicable federal, 
state, or local laws and regulatory requirements (including but not limited to U.S. Food and Drug 
Administration regulations, if applicable) related to its handling and use of EVMs and, if applicable, 
compliance in all respects with such laws and regulations.  

10. User has sole responsibility to ensure the safety of any activities to be conducted by it and its 
employees, affiliates, contractors or designees, with respect to handling and using EVMs. Further, user 
is responsible to ensure that any interfaces (electronic and/or mechanical) between EVMs and any 
human body are designed with suitable isolation and means to safely limit accessible leakage currents 
to minimize the risk of electrical shock hazard.  

11. User shall employ reasonable safeguards to ensure that user’s use of EVMs will not result in any 
property damage, injury or death, even if EVMs should fail to perform as described or expected.  

12. User shall be solely responsible for proper disposal and recycling of EVMs consistent with all applicable 
federal, state, and local requirements.  
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Certain Instructions. User shall operate EVMs within TI’s recommended specifications and environmental 
considerations per the user’s guide, accompanying documentation, and any other applicable requirements. 
Exceeding the specified ratings (including but not limited to input and output voltage, current, power, and 
environmental ranges) for EVMs may cause property damage, personal injury or death. If there are 
questions concerning these ratings, user should contact a TI field representative prior to connecting 
interface electronics including input power and intended loads. Any loads applied outside of the specified 
output range may result in unintended and/or inaccurate operation and/or possible permanent damage to 
the EVM and/or interface electronics. Please consult the applicable EVM user's guide prior to connecting 
any load to the EVM output. If there is uncertainty as to the load specification, please contact a TI field 
representative. During normal operation, some circuit components may have case temperatures greater 
than 60°C as long as the input and output are maintained at a normal ambient operating temperature. 
These components include but are not limited to linear regulators, switching transistors, pass transistors, 
and current sense resistors which can be identified using EVMs’ schematics located in the applicable EVM 
user's guide. When placing measurement probes near EVMs during normal operation, please be aware that 
EVMs may become very warm. As with all electronic evaluation tools, only qualified personnel 
knowledgeable in electronic measurement and diagnostics normally found in development environments 
should use EVMs.  

Agreement to Defend, Indemnify and Hold Harmless. User agrees to defend, indemnify, and hold TI, its 
directors, officers, employees, agents, representatives, affiliates, licensors and their representatives 
harmless from and against any and all claims, damages, losses, expenses, costs and liabilities (collectively, 
"Claims") arising out of, or in connection with, any handling and/or use of EVMs. User’s indemnity shall 
apply whether Claims arise under law of tort or contract or any other legal theory, and even if EVMs fail to 
perform as described or expected. 

Safety-Critical or Life-Critical Applications. If user intends to use EVMs in evaluations of safety critical 
applications (such as life support), and a failure of a TI product considered for purchase by user for use in 
user’s product would reasonably be expected to cause severe personal injury or death such as devices 
which are classified as FDA Class III or similar classification, then user must specifically notify TI of such 
intent and enter into a separate Assurance and Indemnity Agreement.  
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RADIO FREQUENCY REGULATORY COMPLIANCE INFORMATION FOR EVALUATION 
MODULES 

Texas Instruments Incorporated (TI) evaluation boards, kits, and/or modules (EVMs) and/or accompanying 
hardware that is marketed, sold, or loaned to users may or may not be subject to radio frequency 
regulations in specific countries.  

General Statement for EVMs Not Including a Radio  

For EVMs not including a radio and not subject to the U.S. Federal Communications Commission (FCC) or 
Industry Canada (IC) regulations, TI intends EVMs to be used only for engineering development, 
demonstration, or evaluation purposes. EVMs are not finished products typically fit for general consumer 
use. EVMs may nonetheless generate, use, or radiate radio frequency energy, but have not been tested for 
compliance with the limits of computing devices pursuant to part 15 of FCC or the ICES-003 rules. 
Operation of such EVMs may cause interference with radio communications, in which case the user at his 
own expense will be required to take whatever measures may be required to correct this interference.  

General Statement for EVMs including a radio  

User Power/Frequency Use Obligations: For EVMs including a radio, the radio included in such EVMs is 
intended for development and/or professional use only in legally allocated frequency and power limits. Any 
use of radio frequencies and/or power availability in such EVMs and their development application(s) must 
comply with local laws governing radio spectrum allocation and power limits for such EVMs. It is the user’s 
sole responsibility to only operate this radio in legally acceptable frequency space and within legally 
mandated power limitations. Any exceptions to this are strictly prohibited and unauthorized by TI unless 
user has obtained appropriate experimental and/or development licenses from local regulatory authorities, 
which is the sole responsibility of the user, including its acceptable authorization.  

U.S. Federal Communications Commission Compliance  

For EVMs Annotated as FCC – FEDERAL COMMUNICATIONS COMMISSION Part 15 Compliant  

Caution  

This device complies with part 15 of the FCC Rules. Operation is subject to the following two conditions: (1) 
This device may not cause harmful interference, and (2) this device must accept any interference received, 
including interference that may cause undesired operation. Changes or modifications could void the user's 
authority to operate the equipment.  

FCC Interference Statement for Class A EVM devices  

This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to 
part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful 
interference when the equipment is operated in a commercial environment. This equipment generates, 
uses, and can radiate radio frequency energy and, if not installed and used in accordance with the 
instruction manual, may cause harmful interference to radio communications. Operation of this equipment in 
a residential area is likely to cause harmful interference in which case the user will be required to correct the 
interference at its own expense.  

FCC Interference Statement for Class B EVM devices  

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to 
part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful 
interference in a residential installation. This equipment generates, uses and can radiate radio frequency 
energy and, if not installed and used in accordance with the instructions, may cause harmful interference to 
radio communications. However, there is no guarantee that interference will not occur in a particular 
installation. If this equipment does cause harmful interference to radio or television reception, which can be 
determined by turning the equipment off and on, the user is encouraged to try to correct the interference by 
one or more of the following measures:  

 Reorient or relocate the receiving antenna. 

 Increase the separation between the equipment and receiver.  

 Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.  
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 Consult the dealer or an experienced radio/TV technician for help.  

Industry Canada Compliance (English)  

For EVMs Annotated as IC – INDUSTRY CANADA Compliant:  

This Class A or B digital apparatus complies with Canadian ICES-003.  

Changes or modifications not expressly approved by the party responsible for compliance could void the 
user’s authority to operate the equipment.  

Concerning EVMs Including Radio Transmitters  

This device complies with Industry Canada licence-exempt RSS standard(s). Operation is subject to the 
following two conditions: (1) this device may not cause interference, and (2) this device must accept any 
interference, including interference that may cause undesired operation of the device.  

Concerning EVMs Including Detachable Antennas  

Under Industry Canada regulations, this radio transmitter may only operate using an antenna of a type and 
maximum (or lesser) gain approved for the transmitter by Industry Canada. To reduce potential radio 
interference to other users, the antenna type and its gain should be so chosen that the equivalent 
isotropically radiated power (e.i.r.p.) is not more than that necessary for successful communication. 

This radio transmitter has been approved by Industry Canada to operate with the antenna types listed in the 
user guide with the maximum permissible gain and required antenna impedance for each antenna type 
indicated. Antenna types not included in this list, having a gain greater than the maximum gain indicated for 
that type, are strictly prohibited for use with this device. 

Canada Industry Canada Compliance (French)  

Cet appareil numérique de la classe A ou B est conforme à la norme NMB-003 du Canada  

Les changements ou les modifications pas expressément approuvés par la partie responsable de la 
conformité ont pu vider l’autorité de l'utilisateur pour actionner l'équipement.  

Concernant les EVMs avec appareils radio  

Le présent appareil est conforme aux CNR d'Industrie Canada applicables aux appareils radio exempts de 
licence. L'exploitation est autorisée aux deux conditions suivantes : (1) l'appareil ne doit pas produire de 
brouillage, et (2) l'utilisateur de l'appareil doit accepter tout brouillage radioélectrique subi, même si le 
brouillage est susceptible d'en compromettre le fonctionnement.  

Concernant les EVMs avec antennes détachables  

Conformément à la réglementation d'Industrie Canada, le présent émetteur radio peut fonctionner avec une 
antenne d'un type et d'un gain maximal (ou inférieur) approuvé pour l'émetteur par Industrie Canada. Dans 
le but de réduire les risques de brouillage radioélectrique à l'intention des autres utilisateurs, il faut choisir le 
type d'antenne et son gain de sorte que la puissance isotrope rayonnée équivalente (p.i.r.e.) ne dépasse 
pas l'intensité nécessaire à l'établissement d'une communication satisfaisante.  

Le présent émetteur radio a été approuvé par Industrie Canada pour fonctionner avec les types d'antenne 
énumérés dans le manuel d’usage et ayant un gain admissible maximal et l'impédance requise pour chaque 
type d'antenne. Les types d'antenne non inclus dans cette liste, ou dont le gain est supérieur au gain 
maximal indiqué, sont strictement interdits pour l'exploitation de l'émetteur.  

Mailing Address: Texas Instruments, Post Office Box 655303, Dallas, Texas 75265 

Copyright © 2014, Texas Instruments Incorporated 

Important Notice for Users of EVMs Considered “Radio Frequency Products” in Japan 

EVMs entering Japan are NOT certified by TI as conforming to Technical Regulations of Radio Law 
of Japan.  

If user uses EVMs in Japan, user is required by Radio Law of Japan to follow the instructions below with 
respect to EVMs:  
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1. Use EVMs in a shielded room or any other test facility as defined in the notification #173 issued by 
Ministry of Internal Affairs and Communications on March 28, 2006, based on Sub-section 1.1 of Article 
6 of the Ministry’s Rule for Enforcement of Radio Law of Japan,  

2. Use EVMs only after user obtains the license of Test Radio Station as provided in Radio Law of Japan 
with respect to EVMs, or  

3. Use of EVMs only after user obtains the Technical Regulations Conformity Certification as provided in 
Radio Law of Japan with respect to EVMs. Also, do not transfer EVMs, unless user gives the same 
notice above to the transferee. Please note that if user does not follow the instructions above, user will 
be subject to penalties of Radio Law of Japan.  

http://www.tij.co.jp  

【無線電波を送信する製品の開発キットをお使いになる際の注意事項】 

本開発キットは技術基準適合証明を受けておりません。 本製品の 

ご使用に際しては、電波法遵守のため、以下のいずれかの措置を取っていただく必要がありますのでご注

意ください。  

1. 電波法施行規則第6条第1項第1号に基づく平成18年3月28日総務省告示第173号で定められた電波暗室

等の試験設備でご使用いただく。  

2. 実験局の免許を取得後ご使用いただく。  

3. 技術基準適合証明を取得後ご使用いただく。。 

なお、本製品は、上記の「ご使用にあたっての注意」を譲渡先、移転先に通知しない限り、譲渡、移転で

きないものとします 

上記を遵守頂けない場合は、電波法の罰則が適用される可能性があることをご留意ください。  

日本テキサス・インスツルメンツ株式会社  

東京都新宿区西新宿６丁目２４番１号  

西新宿三井ビル  

http://www.tij.co.jp  

Texas Instruments Japan Limited  

(address) 24-1, Nishi-Shinjuku 6 chome, Shinjuku-ku, Tokyo, Japan  
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